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Purpose

This tutorial covers how to configure a brand new Raspberry Pi with the Raspbian OS. It also covers how to
configure a Raspberry Pi as a development platform for the JavaFX platform.

Time to Complete
Approximately 1 hour

Introduction

The Java platform is designed to run on different machines regardless of operating system. Computers comes
in different shapes and capabilities, and Java still runs on most of them. The Raspberry Piis a small,
affordable, and extensible computer that is based on an ARM 11 processor, which is capable of running a
Linux distribution. This new, compact computer also runs Java with the new Java 8 ARM distribution, providing
you with a small and portable device on which to run your applications.

The Raspberry Pi has USB, Ethernet, audio, High-Definition Media Interface (HDML), and RCA composite
video output, making it capable of running applications that connectto the network, are displayed in a
connected screen, and are controlled by using any USB keyboard or mouse.

In this tutorial, you install the Java Development Kit (JDK) for Java Platform, Standard Edition Release 8 (Java
SE 8) on the Raspberry Pi, and then you deploy, run, and stop JavaFX applications directly and remotely in the
Pi.

Software Requirements

Download and install the following software on your PC:

e NetBeans 8 Developer version

e Oracle Java 8 JDK (Windows, Linux, or Mac, depending on your system)
e SD Association Formatter tool

e Win32Disklimager (Windows)

e SHA-1 checksum verifier tool (Windows)

e PuUTTY Telnet and Secure Shell (SSH) Client

e PSFTP client

Download the following software:

e Raspbian Wheezy image (2013-09-16-wheezy-raspbian or later)
e Oracle Java SE 8 JDK for Linux ARMV6/7

Note: File versions and file names might differ.

Hardware Requirements
e Raspberry Pi Model B Revision 2
e 4GB (or larger) Secure Digital (SD) memory card
e Micro-USB power supply (5v, 1A)
e USB keyboard and USB mouse
e HDMI cable
e HDMI-compatible monitor (or TV screen)
e Ethernet cable
e (Optional) Wireless USB module
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Prerequisites
Before starting this tutorial, you should have:

e Read the Raspberry Pi Quick Start Guide forinstructions on how to connect your Raspberry Pito a power
source, a keyboard, amouse, and a monitor.

e (Optional) Completed the Configuring the Raspberry Pi as an Oracle Java Embedded Development
Platform OBE. If you did, you can skip sections 1 and 2 of this tutorial.

Creating a Bootable Image for the Raspberry Pi

In order to boot, the Raspberry Pi requires a bootable Linux image on an SD memory card. There is no hard
drive for the computer. Instead, the 4 GB card stores the image that the computer runs when it is powered on.
This SD memory card also acts as the storage for other applications that are loaded onto the card.

Formatting the SD Memory Card with the SD Formatter Tool
1. Insert the SD card into your computer, or connect it to your computer by using an SD card peripheral.
2. Start the SD Formatter tool and click Option.

Forrﬂatdyour dr:reb. Pill of tne data
on the drive will be lost when you
format it. S '3

SD, SDHC and SDXC Logos are trademarks of
SD-3C, LLC.

Drive : lE: v] L Refresh ]

Size : | 368 GB  Volume Label :

Format Option : [ Option
QUICK FORMAT, FORMAT SIZE ADJUSTMENT OFF

Format

4. Sizes might differ, depending on the SD size.

5. In the Option Setting dialog box, select FULL (Overwrite) from Format Type and ON from Format Size
Adjustment, and then click OK.
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e
FORMAT TYPE {{FULL (Overitite) ) |
P

FORMAT SZE /=)
ADJUSTMENT WON ) M

| oK || | Gancel | |
6. \ J

7. Click Format to start the SD Formatter tool.

Format your drive. All of the data
on the drive will be lost when you S.,

format it. -

SD, SDHC and SDXC Logos are trademarks of
SD-3C, LLC.

Drive : [E: v] [ Refresh ]

Size : [ 368 GB  Volume Label :

Format Option : [ Option
FULL{OverWrite) FORMAT, FORMAT SIZE ADJUSTMENT ON

8.
9. Click OK to format the SD memory card.

g 3 )
SDFormatter [

P ———

Do not remove the drive during formatting.
Are you sure you want to format?

oK [ Cancel ]

—

10. & = —— = /
11. A dialog box displays the progress of the format.


http://www.oracle.com/webfolder/technetwork/tutorials/obe/java/RaspberryPiFX/raspberryfx.html

This tutorial can be found at the URL below:

http://www.oracle.com/webfolder/technetwork/tutorials/obe/java/RaspberryPiFX/raspberryfx.html

- —
Formatting ...

~

Do not remove the drive during formattine.
- Over'Write ERASE 0% [54784 / 7744512]
- Flash ERASE OFF

- Format 0%

Cancel

12. X = = =

>

13. When the format is completed, click OK to close the dialog box.

' " By
SDFormatter @

, Memory Card Format complete !
/' Please remove the Memory Card.
OverWrite FORMAT

Volume Information

- File system : FAT32

- Total space = 3.68 GB (3,955,228,672 Bytes)
- Cluster size = 32768 Bytes

15. Click Exit to close the SD Formatter tool.

14. \

g 1R
{2 SDFormatter V4.0 ==
Forﬂatdypur dr_i'i/i. Pill of tne data
on the drive will be lost when vou p——
format it. S =
SD, SDHC and SDXC Logos are trademarks of
SD-3C, LLC. )
Drive : [E: v] [ Refresh ]
Size : | 368 GB  Volume Label :
Format Option : [ Option )

FULL{OverWrite) FORMAT, FORMAT SIZE ADJUSTMENT ON

[ Format ] [ Exit ]

16. \

J

You are now ready to install the Raspbian Wheezy image in the SD memory card. Leave the cardin the
computer.
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Downloading and Confirming the Raspbian Wheezy Image
17. Make a note of the SHA-1 checksum for the zip file that you downloaded.

Raspbian
Image 2013-09-10-wheezy-raspbian.zip
Torrent 2013-09-10-wheezy-raspbian zip torrent
SHA-1 Checksum 086aa5a95c744b87890c637164c 1186900573968
Default login pi / raspberry

18.

19. Note: The SHA-1 checksum may also be in a file with a .shal extension.

20. Open a command window in the directory where you downloaded the zip file and enter shalsum.exe
2013-09-10-wheezy-raspbian.zip.

rs\tmcginn\Downloads>
B86aa5a25c744h87890c637164c1186900573968 2013-09-18-vheezy—rasphian.zip

C:\Users\tmcginn\Downloads>

|
21. &- T = p e e —

22. Note: If the SHA-1 checksum does not match the checksum listed on the download page, try
downloading the zip file again.

23. Unzip 2013-09-10-wheezy-raspbian.zip with your favorite unzip tool.
24, Start the Win32Diskimager application. Make sure that the device address is the same as the mount
point for the SD memory card.
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-
%4 Win32 Disk Imager

Image File

] MD5 Hash:

Progress

25.

Win32 Disk Imager

194 UAS

Image File
C:/Users/tmcginn/Downloads/2013-09-10-wheezy-raspbian.img [E:\] ~ '

[C] MD5 Hash:

Progress

Cancel || Read | wite || Exit |

4

27. \
28. Click Yes to confirm that you want to overwrite the contents of the SD memory card.

. )

*% Confirm overwrite

& Writing to a physical device can corrupt the device.
;lé Are you sure you want to continue?

Coe )]

29. \
30. A progress meter is displayed.
4 ™
%4 Win32 Disk Imager = | &
Image File Device
C:/Users/tmcainn/Downloads/2013-09-10-wheezy-raspbian.img
] MD5 Hash:
Progress
- 1%
4.54545MB/s
31. . y,
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32. Whenthe Write Successful message is displayed, click OK.

4 N
%5 Complete li—&,l

'6' Write Successful.

33. \ J

34. Click Exit to close Win32 Disk Imager.

g ™\

%4 Win32 Disk Imager | o | E [
Image File Device
C:/Users/tmcainn/Downloads/2013-09-10-wheezy-raspbian.img
[F] MD5 Hash:
Progress

Cancel Read || write [ Edt |
Exit Win32 Disk Imager

35. \ y.

36. Remove the SD memory card from the computer.

You are now ready to boot the Raspberry Pi and install the JDK 8 distribution for Pi.

Setting Up the Raspberry Pi for Remote Access

To set up the Raspberry Pi for remote access, you configure Raspbian to allow SSH connections. To ensure
that the Raspberry Pi always has the same IP address, you configure the Raspberry Pi to use a static IP
address.

Booting the Raspberry Pi and Configuring Raspbian Wheezy Linux
37. Perform the following steps:
a. Insert the SD memory card into the Raspberry Pi.
Connect the USB keyboard and USB mouse.
Connect the HDMI display.
Connect the Ethernet cable.
Plug in the power cable.

© oo o
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ilnsen SD card ‘ = =
ilpin side up =

USB Keyboard |
& Mouse B

38.

39. After a few moments, the monitor displays text, and the Raspberry Pi raspi-config configuration screen
appears.

40. Select setup option 1, Expand Filesystem, and press Enter to expand the file system and use all of
the SD memory card storage.

onl iguration Yool (roxpi-confiy)

1 Expand Fllesysten r sures that all of the SP card storage iz avallable to the O5

2 Change User Passuord password for the default user (pi)

3 Enable Boot to Desktop-Scratch Umsz uhthu to boot l-tu o desktop enwironment, Scratch, or the command-line
4 Internationalisation Options  Set up language and reglonal settings to match your locatfon

% Evable Canera Enable thiz Pi to work with the r

6 Add to Rastrack Md this Pi to the online Raspberry Fi Map (Rastrack)

7 Duerclock Conf igure overclocking for yoor Fi

8 Aduanced Options Configure advanced settings
9 About raspi-confiy Information about this configuration tool

Select> Finish>

41.

42. Press Enter to close the confirmation screen.
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Root partition has been resxzed.
The filesystem will be enlarged upon the next reboot

Configuring the Time Zone
44, Press the up or down arrow key to select option 4, Internationalisation Options, and press Enter.

———— — { Haspberry FI Softuare Configuration Tool (raspi-config) 1—

Setup Options
1 Expand Filesysten Ensures that all of the SP card storage is available to the 05
Z Chanmge User Password Change password for the defanlt user (pi)

3 Enable Boot to DesktopsScratch Choose ubether to boot into a drslm rm\rmnrnl Scratch, or the connand- | ine
Internationalization Options  Set up lang

% Enable Canera Emable this Pl to work with the R-\spbt‘rn' i (‘Anrr\

6 Add to Rastrack M4 this Pi to the online Raspberry Pi Map (Rastrack)
7 Ouerclock Conf igure overclocking for your Pi
8 Aduanced Options Configure advanced settings
9 Mout respi-confliy Information about this configuration tool
Select> <Finish>

45.

46. Press the up or down arrow key to select option 12, Change Timezone, and press Enter.

| Raspberry Fi Software Configaration Tool (raspl-config) [ ———— e

Intermational isation Options

11 Change Locale Set up language and reglonal settings to match your location

13 (hanqc Keyboard Layout Set the kn‘hn«rd lagout to match your keyboard

Gelect) <Back>

47.

48. Press the up or down arrow key to select your country and press Enter.
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49.

50. Press the up or down arrow key to selectthe time zone in your country (if applicable) and press Enter.
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Configuring the Raspbian Wheezy OS to Enable SSH Connections

52. Press the up or down arrow key to select option 8, Advanced Options, and press Enter.

Raspherry Pi Software Configuration Tool (raspl-confiy) f———
Sctup Options
1 Expand Fllesysten Ensures that all of the SP card storage is available to the S
Z Change User Password Chinge password for the default user (pi)

i Enable Boot to Desktop/Scratch Choose ubether to boot into a desktop emvironment, Scratch, or the conmand-1ine
4 Imternationalisation Dptions  Set up language amd regional settings to match your location

5 Emable Cameras Enable this Pi to work with the Baspberry Pl Cancra
6 "dd to Rastrack Add this Pl to the online Raspberry Pi Hap (Bastrack)
7 Duerclock Configure overclocking for your P
9 About raspi-conliy Information about this configuration tool

Select> Finish>

53.

54. Press the up or down arrow key to select option A4, SSH, and press Enter.

————— | Raspberry Pi Software Configuration Tool (raspi-config) ——————
Advanced Options
Al Duerscan You may need to configure overscan if black bars are present on display
A2 Hostnane Set the visible nane for this Pi on a network
A3 Memory Split Change the amount of memory made available to the GPU
A4 SSH EnablesDisable remote command line access to your Pi using SSH
AS Update Update this tool to the latest version
Select> <Back>
55. , —

56. Press the left or right arrow key to select Enable and press Enter.

Would you like the SSH server enabled or disabled?

<Disable>

57.

58. Press Enter.
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SSH server enabled

59.

60. Press the left or right arrow key to select Finish and press Enter.

Setup Optlons

] RaEpberry PI Softuare Configuration Tool (raspi-config) | — -

1 Expand Filesysten Ensures that all of the 5D card storage is available to the 03

2 Change User Password Change password for the default user (ph)

3 Enable Boot to Desktop Choose whether to boot inte a desktop ewironnent or the conmand-1ine
4 Internationalization Options Set up language and regional settings to match gour location

S Enable Canera Enable this Pi to work with the Raspberry Pi Camera

6 Add to Rastrack fndd this Pi to the online Raspberry Pi Map (Rastrack)

7 Ouverclock Configure overclocking for your Fi

Configure advanced scttings
information about this configuration tool

8 Advanced Options
) About ras g

Selecty <P inish

61.

62. Press the left or right arrow key to select Yes and then press Enter to reboot the Raspberry Pi.

- 3 3 _& 4 i
— — 22
== T T TOT -
i Ll e

4\

.1l!’;,‘. “" ‘ tids &
Would you like ‘f”'rﬂ"‘ WL R sk
T HhLidL

Hioe

63.
64. The Raspberry Pi reboots.
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I [ ok ] Starting enhanced syslogd: rsyslogd.
[ ok ) Starting periodic command scheduler:
[ ok ] Starting system message bus: dbus.

! Starting dphys-swapfile swapfile setup ...

» want ~var/swap=100MByte, checking existing:
. dome .

[ ok ) Starting NIF server:

#0
{ ok ) Starting OpenBSD Secure Shell server: sshd.
Ny IP address is 192.168.1.105

| Raspbian GMULinux 7 raspberrypi ttyl
raspherrypl login: _

65.
66. Notice the line that indicates the IP address of the Raspberry Pi.

At this point, you can disconnect the HMDI monitor, the USB mouse, and the USB keyboard.

Connecting to the Raspberry Pi with the Secure Shell
67. Start putty.exe and perform the following steps:
a. On the boot screen, enter the IP address in the IP address field.

b. Enter Raspberry SSH in the Saved Sessions field.
c. Click Save.
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PuTTY Configuration g‘
R 9

Category:

- Sgcsion ] Basic options for your PuTTY session |
T Lf’gf'"g Specify the destination you want to connect to
= ?.mK";:board Host Name (or IP address) Port
- Bell 192.168.1.105 =-— 22
- Features Connection type:
=~ Window (VRaw () Telnet ) Rlogin @ SSH () Serial
gp;:ea@nce Load, save or delete a stored session
- Behaviour
- Translation Saved Sessions
- Selection Raspbeny SSH <—
#Eolaes
[=)- Connection
.- Data
.- Proxy
- Telnet
. Rlogin
- SSH
i Sarial

Close window on exit:
(' Aways Never (@ Onlyon clean exit

[ Open || Cancel

69. Click Open.

68.
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g . A’
, @ PuTTY Configuration @
Category:

=~ Sgcsion } Basic options for your PuTTY session ’

& TEM Lpg?ing Specify the destination you want to connect to
i Host Name or IP address) Port
- Bell 192.168.1.105 22
- Features Connection type:

= Window (VRaw () Telnet () Rlogin @ SSH () Seral
gp;:ea@nce Load, save or delete a stored session
- Translation Saved Sessions
- Selection Raspbemy SSH
-~ Colours Default Settin

as

(=)~ Connection Raspbeny SSH [i]
b
- Telnet

[#-SSH
- Serial Close window on exit:
(' Aways Never (@ Onlyon clean exit
[ open J|[ conce
70. J

71. Click Yes to accept the security alert.

WARNING - POTENTIAL SECURITY BREACH!

The server's host key does not match the one PuTTY has
cached in the registry. This means that either the

server administrator has changed the host key, or you
have actually connected to another computer pretending
to be the server.

The new rsa2 key fingerprint is:

ssh-rsa 2048 33:37:5b:89:25:f3:aa:78:f0:d4:be:7 :08:96:50:d2
If you were expecting this change and trust the new key,
hit Yes to update PuTTY's cache and continue connecting.
If you want to carry on connecting but without updating
the cache, hit No.

If you want to abandon the connection completely, hit
Cancel. Hitting Cancel is the ONLY guaranteed safe
choice.

Yo J|[L N Jf

72. \ ;

Cancel ]

73. Enter pi as the login name and raspberry as the password.
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74.

@ pi@raspberrypi: ~ =B8] & |

log as: pi

Linux raspberrypi 3. MPT Fri Jan 3 18:41:80 GMT 2014 armv6l

included w /Linux em are free software;
ributior S I re described in the
individual files in /u

Debian GNU/Linux comes with ABSOLUTELY NO WARRANTY, to the extent
permitted by applicable 1
Last login: Wed Jan 8 01:36:14 2014 from 192.168.1.205

I

Setting Up the Raspberry Pito Use a Fixed Wired IP Address
If you plan to use your Raspberry Pi on a wireless network, skip this section.

75.

76.
77.

78.

In a separate command-prompt window, enter ipconfig to get the netmask and default gateway for
your network.

p
Command Prompt \ \

Microsoft Windows [Uersion 6.1.76011
opyright (c) 2089 Microsoft Corporation. All rights reserved.

:\Users\tmcginn>

Windows IP Configuration

llireless LAN adapter Wireless Network Connection:

Media State . . . . . . . . . . . = Media disconnected
Connection—specific DNS Suffix H

thernet adapter Local Area Connection:

Connection—specific DNS Suffix . = ‘wll. = O L.&
IPv4 Address. . . . . . « . . . . = 192.168.1.113
Subnet Mask . . . . . . . . . . . = 255.255.255.8
Default Gateway . . . . . . . . . = 192.168.1.1

thernet adapter UirtualBox Host-Only Network:
Connection—specific DNS Suffix . =
IPv4 Address. . . . = = = = - - - = 192.168.56.1
Subnet Mask . . . . . . . . . . . = 255.255.255.09
Default Gateway . “ 04 e e bw S

\Users\tmcginn>

"

Note: If you are using a wireless connection, the information appears under the Wireless LAN adapter
heading.

In a PUTTY window, enter sudo nano /etc/network/interfaces and then perform the following
steps:
a. Commentout the iface eth® inet dhcp line.
b. Below that, add the iface ethe® inet static line.
c. Use your network settings to add the IP, network, netmask, broadcast, and gateway addresses.
For example:
address 192.168.1.105 should be similar to the IPv4 address.
network 192.168.1.0 should be the network prefix and zeroes.
netmask 255.255.255.0 should match the subnet mask.
broadcast 192.168.1.255 should be the network broadcast address.
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gateway 192.168.1.1 should match the default gateway.

GNU nano 2.2.6 File: /etc/network/interfaces Modi

static IP

Add these lines. Use your
network setings.

79. §

80. Note: You have to set the network properties to match the network configuration that you are using on
your PC.

@pi@rasp_be ypi: ~ &

8 Command Prompt
GNU nano 2.2.4 - 4

thernet adapter Local Area Connection:

Connection—specific DHNES Suffix . il = w -
IPv4 fAddress. ;o o= 192 .168.1 [A13]
Subnet Mask . | . . . . oo oo 255 255 2554
Default Gatewal . . . . . . — 192.168.1 .1

81. %

82. Press Ctrl + O and then press Enter to write the file.
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-
@ pi@raspberrypi: ~ | \
GNU nano 2.2.6

File:

/etc/network/interfaces

83. L

84. Press Ctrl + X and then press Enter to close nano and return to the prompt.
85. Enter sudo reboot to reboot the Raspberry Pi and make the changes.

e

@ pi@raspberrypi: ~ =

86.

Optional: Setting Up the Raspberry Pito Use a Wireless Network with a Fixed IP Address

If you plan to use a wireless USB module with your Raspberry Pi, you need to edit the network interfaces file.

87. In a PUTTY window, enter sudo nano /etc/network/interfaces and then perform the following
steps:

a. Commentout the following lines: allow-hotplug wlan@
iface wlan@ inet manual

wpa-roam /etc/wpa_spplicant/wpa_supplicant.conf
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b. Below that, add the following lines: auto wlan@
iface wlan@ inet static
c. Use your network settings to add the IP address, network mask, and gateway address. For
example:
address 192.168.1.105
netmask 255.255.255.0
gateway 192.168.1.1
d. Add the network SSID and passkey for your network in double quotation marks. For example:
wpa-ssid "mynetwork"
wpa-psk "cants@y"

-
: e = |
@ pi@raspberrypi: 2 - - - \
GNU nano 2.2.6

File: /etc/network/interfaces Modi

Comment out these

Add your network SSID and network
v key>"ji security key in double quotes.

88.

89. Press Ctrl + O and then press Enter to write the file. Press Ctrl + X to exit nano.
90. Enter sudo halt to halt the Raspberry Pi.

p
@ PuTTY (inactive) (=)

91. §
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92. Unplug the power cable to the Raspberry Pi.
93. The Raspberry Pi supports only two USB connections. To use the USB Wifi module, unplug the USB

mouse, the USB keyboard, and the Ethernet cable, and then plug in the USB Wifi module.

94. To use JavaFX applications, you need a mouse and preferably a keyboard. You can use a USB hub to
connect everything to the Raspberry Pi.

96. Plug the power cable into the Raspberry Pi.

Restarting the PUTTY Connection
97. To reconnect to the Raspberry Pi, right-click in the header of the PUTTY window and select Restart

Session.
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r@ PuTTY (inactive) |_|
Restore
Move
Size

- Minimize

o  Maximize

x Close

Event Log

New Session...

Restart Session

Duplicate Session
Saved Sessions

Change Settings...

Copy All to Clipboard
Clear Scrollback

Reset Terminal

Full Screen

98. \

99. Enter pi as the login name and raspberry as the password.

-

EP pi@raspberrypi: ~ Iil.

100.

Installing JDK 8 in the Raspberry Pi

Raspbian comes with an installed version of Java. To install a new version of Java with the full JDK, you
transfer the ARMV6/7VFP gzip distribution to the Pi by using PSFTP. After the gzip is on the Pi, you unzip it
and setthe required environment variables.
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Transferring JDK 8 to the Raspberry Pi by Using PSFTP

101.

102.
103.

104.

105.
106.

107.
108.

109.

Launch the PSFTP tool and then perform the following steps:
a. Enter open 192.168.1.105.
b. Enter pi as the login name and raspberry as the password.

#

£2 PSFTP.EXE - Shortcut EIEINN

ecified; use "open host.name" to connect

If a dialog box about a cached key is displayed, press Y to update the key.

Enter 1cd C:\Temp to change the local directory to the location of JDK 8 for Linux ARMv6/7.

\

2 PSFTP.EXE - Shortcut =& =

ied; use "open host.name" to connect

h, A

Enter put jdk-8-ea-bl24-linux-arm-vfp-hflt-17_jan_2014.tar.gz.

s 0 e

This process may take several minutes because it uploads JDK to the Raspberry Pi.

Type exit to quit the PSFTP tool.
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# \

£2 PSFTP.EXE - Shortcut =[] 58 |

d; use "open host.name" to connect

110. \ )/

Installing the Raspberry Pi JDK 8
111 In the PUTTY window, enter tar -xvf jdk-8-ea-bl124-linux-arm-vfp-hflt-
17_jan_2014.tar.gz to extract JDK 8.

@ pi@raspberrypi: ~ | = | E 23 |

o the extent

-hflt-17_ja
112, -
113. Files are extracted inside the jdk1.8.0 folder. (The process may take several minutes.)
114. If a message indicates that some files have a timestamp, perform the following steps to correct
the error:
115. Solving Timestamp Error
116. Enter sudo update-alternatives --install /usr/bin/java java

/home/pi/jdk1.8.0/bin/java 1.

2 s S -~~~ =

117.

118. Enter sudo update-alternatives --set java /home/pi/jdk1.8.0/bin/java.
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i@raspberrypi: ~ |‘:' =l 23 |
P poerryp

119. J
120. Enter nano .profile.
nano .p "I::fili':l -
121.
122. At the bottom of the file, add the following:
123, JAVA_HOME="/home/pi/jdk1.8.0" export JAVA HOME PATH="$JAVA HOME/bin:$PATH"
( @ pi@raspberrypi: ~ | = | [E 23 .|\
GNU nano 2.2.6 File: .profile -
s private bin
124, e : . ———— )

125. Press Ctrl + O and then press Enter to save the changes. Press Ctrl + X to exit nano.
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Ee pi@raspberrypi: ~ | == 23 |

GHU nanoc 2.2.6 File: .profile -

126.

Setting Up JAVA_HOME for sudo Commands
127. In the PUTTY window, enter sudo visudo.

@ pi@raspberrypi: ~ | = | E 23 |
sudo visud |::|:|

128. \ )

129. Enter Defaults env_keep +="JAVA_HOME" after all the Defaults declarations.
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~

pi@raspberrypi: ~ == =
GNU nano 2.2.6 File: fetc/sudoers.tmp Modified

command as root.

instead of

ny command

ation on "#include™ directiv

m

Cut Text
Justify J 5 UnCut Te» ) e -
130. \ ; )
131 Press Ctrl + O and then press Enter to save the changes. Press Ctrl + X to exit nano.
( pi@raspberrypi: ~ EEIE=S )

GNU nano 2.2.6 File: /fetc/sudoers.tmp

t This file M

alias specification

ification

132. = ' )



http://www.oracle.com/webfolder/technetwork/tutorials/obe/java/RaspberryPiFX/raspberryfx.html

Thistutorial can be found at the URL below:

http://www.oracle.com/webfolder/technetwork/tutorials/obe/java/RaspberryPiFX/raspberryfx.html

133. Using visudo, you edit the sudoers file safely. After the editor is closed, the file is validated. If
any validation errors are in the file, the sudoers file is not modified.

Verifying the JDK 8 Installation
134. Enter sudo reboot to restart the Raspberry Pi. Wait a couple of seconds to let the Raspberry
Pi reboot.

@ pi@raspberrypi: ~ | = | [E 23 |

sudo reboot

} (Tue Jan 28 17:48:46 2814):

135.

136. Right-click in the header of the PUTTY window and select Restart Session to reconnect to the
Raspberry Pi.

2 e I = =

Restore

Maowve
Size
—  Minimize
o Maximize
x (lose Alt+F4

Event Log

New Session...

Restart Session

Duplicate Sessicn
Saved Sessions 3

Change Settings...

Copy All te Clipboard
Clear Scrollback

137.

138. Enter pi as the user name and raspberry as the password.
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2 oot S ==
sudo re t -

139.

140. Enter java -version to see the current Java version that is being used.
( @ pi@raspberrypi: ~ | = | [E 23 .|\

141.

142. Note: Your Java version should be at least 1.8.

143. Enter javac -version to seethe currentJava compiler version that is being used.
( @ pi@raspberrypi: ~ | = | [E 23 .|\

144.

145. Note: Your Java version should be at least 1.8.

146. Enter sudo java -version to see the Java version that is being used by the root user.
( @ pi@raspberrypi: ~ | = | [E 23 .|\

147.

148. Note: Your Java version should be at least 1.8.
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Building JavaFX Applications

To develop JavaFX applications faster, you use your desktop computer with the NetBeans IDE. The JavaFX
projects generate JAR files that can be deployed to any device that can run JavaFX. In this section, you create
two applications with NetBeans and move the resulting JAR files to upload them later to the Raspberry Pi.

Building a Basic JavaFX Application
149. In NetBeans, select File > New Project.

(] NetBeans IDE Dev javame8-5-on-2013092°

Edit View MNavigate Source Refactor Run Debug Profile Teamn Teools Window Help [

1 New Project... Ctrl+ Shift+ N | O TH VP BR-&
T NewFile.. Ctrl+N -

Open Project... Ctrl+Shift+0
Open Recent Project 4
Close Project
Open File...

Open Recent File 4

Project Group 4
Project Properties

Import Project 4
Export Project k

Save Ctrl+5
utput 2

Save As...

Save All Ctrl+Shift+5

150 Page Setup...

151. Select JavaFX from Categories and JavaFX Application from Projects and click Next.
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rO Mew Project l 28 J1

Steps Choose Project

1. Choose Project Q, Filter:
2 ..

Categories:

[~--W JavaFX Application

(%, JavaFX Preloader

&, JavaFX FXML Application
Q‘ JavaFX in Swing Application

----- L Java

----- ), JavaWeb
----- L) JavaEE
..... |j HTMLS

----- ), Java Card B
----- L Java ME

..... |j Maven

..... 1. PHP i

Description:

| »

m

Creates a new Java application with enabled JavaFX -
features in a standard IDE project. You can also aenerate a [
javafu_application.Applicasion Main class with sample JavaFX code

< Back Finish [ Cancel ][ Help ]

152. \
153. Enter BasicFX as the project name, select a location for the project, and click Finish.
i E:] Mew JavaFX Application l 28 J1
Steps Name and Location
1. Choose Project Project Name: m

2. Name and Location

Project Location:  D:‘\WetBeansProjects

Project Folder: D:\NetBeansProjects\BasicFX

JavaF Platform: DK 1.8 (Default v | | Manage Platforms...

[7] Create Custom Preloader

Project Mame: |BasicFX-Preloader

[7] Use Dedicated Folder for Storing Libraries

Libraries Folder: Browse...

Different users and projects can share the same
compilation libraries (see Help for details).

Create Application Class | basicfx.BasicFX

Mext = [ Finish ][ Cancel ][ Help ]

154. . /

155. Your project is created and loaded into the IDE, and you can explore the contents of the project.

156. Right-click the project and select Clean and Build to generate a distributable JAR file.
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1 |

File Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help [
PP D (ot Q- W D E-D -
Pro... % |Files | Services| [ ||l BasicFXjava |
---h#‘ oy B EB-H- QT E20IPH
Mew L4
Build
Clean and Build
Clean
Generate Javadoc
ackage basicfx;
Run
Debug port javafx.application.Application;
Profile [ i
Navigator Test Alt+F6
Members Set Configuration L4
EI@. Ba
H @ Open Required Projects
- @ Close
Rename...
Move...
Copy...
Delete Delete
157. W M _ o
158. Click Select Class in the Browse JavaFX Application Classes if the dialog box is displayed.

[ Select Class ][ Cancel

159. ¥The Output tab shows the

progress and indicates when the process is completed.

Qutput - BasicFX (jfx-rebuild) = | =1
Launching <fx:jar> task from D:ih\software‘dev-toolshjdkl 7.0_45%jreh. A 1ib' &
Warning: From JDETuZS the Codebase manifest attribute should be used to &

Please set manifest.custom.codebase property to override the cur
Launching <fx:deploy> task from D:\softwareldev-toolshjdkl.7.0_45%jre’ . . %
JjEfx-deployment—script:

RO T

jfx—deployment:

jar:
Jfx—-rebuild:
I BUILD SUCCESSFUL (total time: 4 seconds)

m

El

1 10 | r

160. Open a File Explorer window and locate the project folder.


http://www.oracle.com/webfolder/technetwork/tutorials/obe/java/RaspberryPiFX/raspberryfx.html

This tutorial can be found at the URL below:

http://www.oracle.com/webfolder/technetwork/tutorials/obe/java/RaspberryPiFX/raspberryfx.html
)
W0 MetBeansProjects\BasicFX

Organize » Include in library « Share with «

build dist
File folder File folder

nbproject - src
File folder File folder

build.xml manifest.mf
XML File MF File
305 KB 85 bytes

161.
162. Open the dist folder and locate the BasicFX.jar file
FEFETS)
WD\ NetBeansProjects\BasicFX\dist Search dist P
Organize = @ Open - Burn Mew folder
Mame ° Date modified
1. web-files 29/01/2014 12:18 ... File folder
| BasicFX.html 29/01/2014 1218 ... Firefox HTML Doc...
|5 BasicFX.jar 29/01/2014 12:18 ...  Executable Jar File
=] BasicFX.jnlp 29/01/201412:18 ... IMLP File
163.

164. Copy the BasicFX.jar file to c:\Temp to make it easier to upload to the Raspberry Pi.
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[ =lETs=T))
O < omcoramr - [b| e p]

COrganize =

[£] Open = Burn MNew folder B~ 0O @

Mame Date modified Type

29/01/2014 1218 ... File folder

|| BasicFX.html 29/01/201412:18 ... Firefox HTML Doc..
@ BasicFX.jar 20/01/2014 12:18 ...  Executable Jar File
|| BasicFx.jnlp 20/01/2014 12:18 ..  JNLP File

11 web-files

E=AFEAS)

Organize * @] Open Burn MNew folder =~ [ @
Mame Date moedified Type
| l+| BasicFX jar 29/01/201412:18 ...  Executable Jar File

jdk-8-ea-bl24-linux-arm | ¢ (pflt-17 jan...  27/01/2014 02:39 .. z Archive
I &y g

+ Copy to Temp 4 )
165.

Building the Clock Sample JavaFX Application
The NetBeans IDE includes sample applications that you can create and modify to showcase Java
technologies. In this section, you create a JavaFX clock application by using one of these templates.

166. In NetBeans, select File > New Project.
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) BasicPX - NetBeans I

m Edit View Mavigate Source Refactor Run Debug Profile Team Tools Window Help

#h New Project.. CtrlShifteN |1 LT B D@
T Mew File... Ctrl+N
s u
[ Open Project... Ctrl+Shift+ O ory | -5 - | SR R | & -
Open Recent Project 4
Close Project (BasicFx) To change this license header, cho
Open File... To change this template file, ct
Open Recent File y|2nd open the template in the edito
Project Group 4
- - - kage basicfx:
Project Properties (BasicFX)
Import Project piort javafx.application.iApplication
Export Project L4 L
Save Ctrl+5 - 8
FX (jfx-rebuild) =
Save As... ning <fx:jar> task from D:wsoftware'\dew-
Sawve All Ctrl+Shift+5 ng: From JDE7u2S the Codebase manifest =
Please set manifest.custom.codebase
167 Page Setup,,, ning «fx:deploy> task from D:h\software'd
168. Select Samples > JavaFX from Categories and DigitalClock from Projects and click Next.
b
Ot sl
Choose Project
Q, Filter: |
Categories:
=) Samples
w1l Java CreateAdvancedStage
Ce0
U—J G CeS stem30D
Web Servi DigitalClock
, U_) 2D Services Displayshe
o L JavaEE Fireworks
ol Maven 5 FXML-LoginDemo
4 I &% HTMLEditorApp
Description:
A digital dodk application that demonstrates JavaFX animation, images,
and effects.
ﬂ Mote that samples are instructional and may not indude all
security mechanisms required for a production environment.
| <Back || MNext> || Fiish || Cancel || Hep |
169.

170. Set a location for the project and click Finish.
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() New DigitalClock Y

Steps Mame and Location
1. Choose Project Project Name:

2. Name and Location

Project Location: |D:\NetBeansProjects

Project Folder: D:\NetBeansProjects\DigitalClock

JavaFX Flatform: 'JDK 1.8 (Default) = l Manage Platforms. ..

Mext = [ Finish H Cancel l Help

171.
172. The project is created with the code required to display a digital clock using JavaFX.
173. Right-click the project, select Clean and Build, and wait until the project is built.
1|l::l.‘:'rlﬁ'.=.m'z-;=-m‘n:-n.:»
File Edit VWiew Mavigate Socurce Refactor Run Debug Profile Team Tools Window Help E
Iz D@ e QT B D BB
Pro... % |Files |Services| [l||[&) BasicFX.java |
@. BasicFX Source | History | E - &l v| Lo | 47 4k, B
&
MNew L4
Build
| Clean and Build
Clean
Generate Javadoc sge basicfx;
Run . . . . .
rt javafx.application.Application;
Debug =
Navigator El Profile
:Members Test Alt+F6 (ifx-rebuild) %
EI&) BasicFX Set Configuration 4 ng <fx:jar> task from D:ysoftwareidev-too
, kﬂ) ma : From JDE7uZ5 the Codebase manifest attx
a sa Open Required Projects Plezse set manifest.custom.codebase pro
~ Close ng <fx:deploy> task from D:hsoftwarehdew-
loyment—script:
Rename... loyment :
Lt nild:
Copy... UCCESSFUL (total time: 4 seconds)
& @@ Delete Delete
1
Find... Ctrl+F
174. L Tmimmrb o Tomim e renm ]
175. Open a File Explorer window, browse to the DigitalClock project folder, and open the dist

folder.
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R )

Kol el | D:\NetBeansProjects\DigitalClock\dist - Search dist o

Organize « Include in library « Share with »  »

e
Mame Date modified

|| web-files 29/01/2014 12:49 .. | Change your view. |

| | DigitalClock.html 29/01/201412:49 ... Firefox HTML Doc...
] DigitalClock.jar 29/01/2014 12:49 ... Executable Jar File
|| DigitalClock jnlp 29/01/2014 12:49 ... JMLP File

176.
177. Copy the DigitalClock.jar file to the c:\\Temp folder to make it easier to deploy it on the
Raspberry Pi.

Crganize « @J Open - Burn Mew folder ==« i @

Mame B Date medified Type

. web-files 29/01/201412:49 ... File folder

|| DigitalClock.html 29/01/201412:49 ...  Firefox HTML Doc...

|| DigitalClock.jar 29/01/2014 12:49 ...  Executable Jar File

|| DigitalClockjnlp 29/01/201412:49 ... JMLP File

« m 3
E=rE
€ -.“ (C) » Temp - Search Temp o
Organize - @] Ope\ - Burn Mew folder = » [l I@
Mame B ‘ Date modified Type
&) BasicFX jar 29/01/2014 1218 ...  Executable Jar File
| |£| DigitalClock.jar 29/01/2014 12:49 ...  Executable Jar File
@jdk-ﬁ-ea-bllﬂl-linux-arn &\ |hfit-17) jan...  27/01/2014 02:39 ... gz Archive
+ Copy to Temp
L)
178.

Deploying, Running, and Stopping JavaFX Applications
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Transferring the JavaFX Application JARs to the Raspberry Pi by Using PSFTP
179. Launch the PSFTP tool and then perform the following steps:
a. Enter open 192.168.1.105.
b. Enter pi as the login name and raspberry as the password.

£2 PSFTP.EXE - Shortcut =[] 5% |

ed; use "open host.name"™ to connect

rd: raspberry
: Jhome/pi

180.
181. Perform the following steps to transfer the JavaFX application JAR files:
a. Enter 1cd C:\Temp to change the local directory to the location of the JDK 8 for Linux
ARMV6/7.
b. Enter put BasicFX.jar.
c. Enter put DigitalClock.jar.
[ 23 PSFIP.EXE - Shortcut ===
se "open host.name" to connect
Shome/pi
cihTemp
e:/home/pi/fBasicF¥.jar
Shomespi/DigitalClock.jar
182.
183. Type exit to quit the PSFTP tool.

The applications are deployed on the Raspberry Pi.

Running a JavaFX Application JAR inthe Raspberry Pi
184. In a PUTTY window, enter sudo halt and wait for the LEDs to stop blinking.

@ pi@raspberrypi: ~ | = | E 23 |

sudo halt

) (Tue Jan 28 18:45:84 2014):

185.

186. When only the PWR LED is on, unplug the power cable from the Pi.
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187.

188. Connect the video cable, mouse, and keyboard to the Raspberry Pi, and then connect the
power cable.

189.

190. In the Pi, log in as the user pi with the password raspberry.
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jl Pounting local filesystens...( 17.168431]1 FAT-fs (mmcblkOpl): Uolume was wnot properl

fotivating swapfile swap. . .done.
Cleaning up temporary flles.
Setting kernel variables done
Configuring network interfaces...done.
' Cleaning up u-poru'y files..
i Setting up ALSA. .
l...t..) Setting console .creen -Mcs
Linfo) Skipping font and keymap setup (handled by console-setup).
[ ok ) Setting up console font and keymap...done.
[ ok J Setting up X socket directories... /tap/ . Xil-unix /tmp/. ICE-unix.
INIT: Entering runlevel: 2
[info) Using makefile-style concurrent boot in rumlevel 2.
[ ok ) Network Interface Plugging Daemon...skip etho...done.
{
{o
Starting dphys-swapfile swapfile setup ...
want svar/swap=100MByte, checking existing: keeping it
done .

[ ok ] Starting NTP server: wntpd.

[ ok ] Starting systen message bus: dbus.

{ ok 1 Starting OpenBSD Secure Shell server: sshd.
My IF address is 192.168.1.105

Raspbian GNU/Linux 7 raspberrypi ttyl

NI'WI login: pi

Password

l..ntln.ln Tue Feb 4 18:53:36 CST 2014 from 192.168.1.205 on pts/®
Linux rospboreypl 3.10.25¢ 8622 PREEMPT Fri Jan 3 18:41:00 GNT 2014 armubl

The progrens included with the Debian GMU/Linux system are free software:
the oxact distribution terns for cach progrem are described in the
individual flles in susrssharesdoc/=/copyright.

Doblan GMULinux comes with ABSOLUTELY NO MARRANTY, to the extemt
pormittod by applicable law.
plifraspberrypl &

191.

192. Enter java -jar BasicFX.jar.

Raspbian GNU/Linux 7 raspberrypi ttyl
raspberrypi login: pi
Password:

Last login: Tue Feb 4 18:54:33 CST 2014 on ttyl
Linux raspberrypi 3.10.25+ 8622 PREEMPT Fri Jan 3 18:41:00 GNT 2014 armu6l

The programs included with the Debian GNU/Linux system are free software:
the exact distribution terms for each program are described in the

individual files in ~usr/shares/doc/#/copyright.

Debian GNU/Linux comes with ABSOLUTELY NO WARRANTY, to the extent
permitted by applicable law.
pifrespberrypi ~ 5 java -jar BasicFX. jar

193.

194. The application is displayed on the Raspberry Pi screen.
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195.

Stopping a JavaFX Application

JavaFX applications are displayed on the main screen of the Raspberry Pi, but you can start and stop them
from a remote console, which is useful when debugging or when the application cannot be stopped. In some
cases, you can stop applications by pressing Ctrl + C. If the application doesn't stop, use the method outlined
in this section.

196. On your Desktop PC, open a PUTTY window and log in to the Raspberry as the user pi with the
password raspberry.
197. Enter ps ax | grep java and locate the process ID of the BasicFX.jar application.

@ pi@raspberrypi: ~ | = | [E 23 |

1 i

Fri Jan 3 18:41:88 GMT 2814 armvél
m are free st
cribed in th
SOLUTELY MO WARRANTY, to the extent

from 192.168.1.205

Process ID

198.

199. Enter sudo kill -9 2326 and replace 2326 with the process ID from the previous step.
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PREEMPT Fri Jan 3 15:41:8@ GMT 2814 armv6l

200.

201. Notice that the JavaFX application stops.
Raspbian G6NU/Linux 7 raspberrypi ttyi
raspberrypi login: pi
Password :
Li':st login: Tue Feb 4 18:54:33 CST 2014 on ttyl
Linux raspberrypi 3.10.25+ #622 PREEMPT Fri Jan 3 18:41:00 GMT 2014 armu6l
The programs included with the Debian GNU/Linux system are free software:
thc_exact distribution terms for each program are described in the
individual files in susr/share/doc/#/copyright .
Debh.m GNU/Linux comes with ABSOLUTELY NO WARRANTY, to the extent
y?-lutted by applicable law.
pi@raspberrypl = 5 java - jar BasicFX. jar
glGetError 0x505 2
Hello World?
Hello Worldt
Hello Worldt
Hello Worldt
Killed
pi@raspberrypi

202.

You can use this method whenever you cannot shut down an application normally and you need to forcefully
stop it.

Running a JavaFX Application Remotely

203. In the PUTTY window, enter java -jar DigitalClock.jar.

8 visoverr:- S - ==~

204.

2065. The Digital Clock application starts and runs in full screen mode.
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206.
207. In the PUTTY window, press Ctrl + C to stop the application.
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o ool

ol

ol ol oo
= =h = =h =h =h =k —h

ol

.run(ThreadPo
c.quantum.QuantumRenderer$PipelineRunnable. run

.;.Th’Ead.’un[Th’Ead.j
208.

Conf guring netwo k interfaces.. done.
leaning up t mp ary files...
Setting up ALSA...done.
console screen modes.
kipping font and k ymap s tup (handled by console-setup).
etting up console font and keymap...done.

X sock t directori s... /tmp/.X11-unix 7tmp/ . ICE-unix.
INIT: Enter runlevel: 2

Cinfol Using makefile-style concurrent boot in runlevel 2.
ok  Network Interface Plugging Daemon...skip eth@...done.
Starting enhanced syslogd: rsyslogd
periodic comman scheduler: cron.
system message bu : db s.
Starting dphys-swapfile swapfile etup . .
want svar/swap=100MByt , checking xisting: keeping it
do e.
[ ok 1 Starting NTP server: ntpd.
OpenBSD Secure Shell server: sshd.
My IP address is 192.168.1.105

ok

Raspbian GNU/Linux 7 raspberrypi ttyl

raspberrypi login: pi
P swo d:
L t login: Tue Feb 4 18:54:33 CST 2014 on ttyl
inux raspberrypi 3.10.25+ #622 PREEMPT Fri Jan 3 18:41:00 GNT 2014 armub

The programs included with the Debian GNU/Linux system are free software:
t exact distrib tion terns for each program are describ d in the
individual files in ~susrssharesdoc/#/copyright.

Debian GNU/Linux comes with ABSOLUTELY NO WARRANTY, to the extent
p rmitted by applicable law.

pieraspberrypi ~ $ java -jar BasicFX. jar

glGetError 0x505

Hello World?

Ki ed
pi@raspberrypi
pi@raspberrypi

2009. If the screenis blank, press Enter to display the shell console.

Summary
In this tutorial, you learned to:
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e Create a bootable image for the Raspberry Pi

e Set up the Raspberry Pi for remote access

e Install JDK 8 on the Raspberry Pi

e Deploy and run JavaFX applications on the Raspberry Pi
¢ Run and stop JavaFX applications remotely

Resources
e Raspberry Pi Foundation
e JDK 8 Project page
e Tolearn more about Java 8 and the Raspberry Pi, refer to additional OBEs in the Oracle Learning
Library

Credits

e Lead Curriculum Developer: Eduardo Moranchel
e Other Contributors: Tom McGinn
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http://www.raspberrypi.org/
https://jdk8.java.net/
http://www.oracle.com/goto/oll
http://www.oracle.com/goto/oll
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